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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Introduction
This guide covers the installation, configuration, and use of the pro-xi 100 Workstation Integrator. The following 
chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.

• “Hardware Overview” presents information on the pro-xi 100 hardware components and features.

• “Physical Installation”summarizes the installation of the pro-xi 100.

• “Cabling” provides interconnect diagrams and examples of how to cable single-head and dual-head setups.

• “Initial Startup Display” describes the initial display window areas and features.

• “Connected System Windows” outlines how to move a window and resize a window.

• “Controlling Connected Systems” outlines the ways of taking control of connected computer systems.

• “Creating and Using Sub-windows” describes how to create, move, resize and pan sub-windows.

• “Creating and Using Layouts” provides information about the layout function of the pro-xi 100.

• “System Menus” provides information on the menus for the pro-xi 100 system.

• “Installing the proxi-app Utility” briefly outlines how to install the proxi-App utility which is used to create or 
edit configurations for your pro-xi 100 system.

• “Creating a New Configuration” outlines how to launch the proxi-App utility and create a new configuration 
including configuring the VOC cards, the ISC cards, and specifying the network settings.

• “Testing a Configuration Using a USB Drive” describes how to format and create a USB drive that can be used 
to export the pro-xi 100 system.

• “Exporting a Configuration via USB” outlines the process of using a USB drive to export a configuration to 
the pro-xi 100 system.

• “Exporting a Configuration Across the Network” outlines the process of exporting a configuration to the 
pro-xi 100 system over your facility network.

• “System Upgrades via a USB” outlines how to upgrade your system using a USB drive.

• “System Upgrades via a Network” outlines how to upgrade your system using a network connection.

• “System Window Frames” describes the components and configuration options of the system window frames. 

• “Bezel Color Notifications” outlines how to customize the illuminated front bezel of the pro-xi 100.

• “Real Time Clock Display” outlines the display and configuration options for the RTC feature of the pro-xi 100.

• “Desktop Settings” provides information on the desktop options, such as the status bar and the bug icon, for the 
pro-xi 100 system.

• “Dual Operator Configuration” describes the steps for configuring the pro-xi 100 system for dual operators.

• “Dual Operator Operations” provides an overview of controlling a dual operator system.

• “Keyboard Shortcuts” lists the keyboard shortcuts for carousel control, system activation, and other common 
functions.

• “Video Test Patterns” briefly summarizes the elements of the available video test patterns.

• “Technical Specifications” provides the technical specifications for the pro-xi 100 system.

• “Software Licenses” provides third-party software license information for the pro-xi 100 system.

• “Creative Commons 3.0 License” provides information on the movie images licensed under the Creative 
Commons 3.0 Attribution license.

• “Service Information” provides information on the warranty and repair policy for your pro-xi 100 system.

• “Glossary” provides a list of terms used throughout this guide.
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Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your unit:

• pro-xi 100 Quick Start Guide, Ross Part Number: PRO100DR-002

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Edit dialog, click Apply.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the pro-xi 100 Quick Start Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would select the File menu and then select Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They 
will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your pro-xi 100.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), 
technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, 
a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to 
react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886

• After Hours Emergency: (+1) 613-349-0006

• E-mail: techsupport@rossvideo.com 

• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Hardware Overview
Each pro-xi 100 system rack frame provides dual redundant AC power inputs, a Single Controller card (CTC), one 
or two Video Output Controller cards (VOC), and up to eight Video Input Controller cards (ISC). This chapter 
presents information on all of the pro-xi 100 hardware components and features.

Overview

The primary pro-xi 100 system rack frame supports:

• one or two Operator positions

• one or two output displays

• up to eight controlled systems.

Rear Panel Overview

The rear view of the pro-xi 100 system is shown in Figure 2.1, along with the location of each of the cards in the 
rack frame.

Figure 2.1  pro-xi 100 — Rear Panel Components

The Operator stations use a combination of the CTC card (for mouse, keyboard and audio out) and one or both 
VOC cards (for video output). Each of the connected computer systems are attached to the various ISC cards using 
two USB A-to-B cables, a DVI/VGA cable and (optionally) an audio input cable.

CTC Card Connections

Figure 2.2 illustrates the connections to the Single Controller Card (CTC) of the pro-xi 100 system.

Figure 2.2  CTC Card — Connections
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Audio Out Port

The audio out connection is a standard 3.5mm stereo audio signal that can be connected to an amplified speaker pair 
or other audio device.

Mouse/Keyboard Ports

The top two USB connections are used to attach your USB mouse and keyboard to the pro-xi 100 system.

USB Drive

The bottom USB connection is used for a USB drive.

Ethernet Port

The Ethernet connection supplies a 10/100Mbps network connection to a switch, hub or other network device.

VOC Card Connections

Figure 2.3 illustrates the connections to the pro-xi 100 system’s Video Output Card (VOC). 

Figure 2.3  VOC Card — Connections

DVI-D Video Output Port

The DVI-D output can drive any standard DVI video monitor, and can support output resolutions as high as 
2560x1600.

When using two VOC cards as a single Operator station, the output of the pro-xi 100 system appears as a standard 
dual-head computer, and can provide a working canvas that is 5120x1600 in size.

ISC Card Connections

Figure 2.4 illustrates the connections to the pro-xi 100 system’s ISC card.

Figure 2.4  ISC Card — Connections
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Audio In Port

The audio in connection is a standard 3.5mm stereo audio signal that can be connected to the output of any desktop 
or laptop computer, hand-held device, or racked system.

Mouse/Keyboard Ports

The two USB connections are used to attach the USB mouse and keyboard to the connected computer.

DVI/VGA Video Input Port

The DVI/VGA video input connection is used to attach the video output from the connected computer to the pro-xi 
100 system. It can support input resolutions as high as 2048x1536.

When connected, the pro-xi 100 system will appear as a standard USB mouse, USB keyboard and DVI or VGA 
monitor to the connected computer. No drivers or other software needs to be installed on the connected computer 
for it to operate with the pro-xi 100 system.

 Two USB A-To-B cables must be used to connect the host computer to the pro-xi 100 system.
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Physical Installation
If you have questions pertaining to the installation of pro-xi 100, please contact us at the numbers listed in the 
section “Contacting Technical Support”. Our technical staff is always available for consultation, training, or 
service.

For More Information on...

• the technical specifications for the pro-xi 100, refer to the chapter “Technical Specifications” on page 109.

• notices to service personnel, refer to the document pro-xi 100 Important Regulatory and Safety Notices that 
shipped with your pro-xi 100.

Static Discharge

Throughout this guide, please heed the following cautionary note: 

Unpacking the pro-xi 100 System

Unpack each pro-xi 100 you received from the shipping container and ensure that all items are included. If any 
items are missing or damaged, contact your sales representative or Ross Video directly.

When unpacking the system, be sure to verity that it contains:

• the pro-xi 100 system

• a keyboard

• a mouse

• two power cords

• a rack-mount hardware kit

Figure 3.1  Example of pro-xi 100 Shipping Box Contents

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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Rack-mounting and Installing the pro-xi 100

The pro-xi 100 system requires three rack-units (5.25" / 13.34 cm) of vertical rack space.

The pro-xi 100 system is shipped with a rack mount kit, and installation of the pro-xi 100 system in a rack is done in 
three steps:

1. Attach rack rails to the pro-xi 100 system.

2. Attach rail supports to the rear rack rails.

3. Mount the pro-xi 100 system in the rack and attach it to the front rack rails.

To ensure long life for this product, observe the following precautions and operating requirements:

• Maintain an ambient temperature of 0°C to 40°C (32°F to 104°F).

• Allow for air circulation around the chassis for convectional cooling.

Attaching the Rack Rails to the pro-xi 100 System

The rail extensions can be attached to the mounting brackets in a number of different locations to set their extension 
distance to fit racks of varying depths.

Figure 3.2  Example of Attaching the Rack Rails

To attach the rack rails to the pro-xi 100 system

1. Measure the depth of the rack the pro-xi 100 system is to be mounted in.

2. Set the extension distance as required.

3. Attach the left and right mounting brackets to the pro-xi 100 system. (Figure 3.2)

4. Attach the rail extensions to the pro-xi 100 system. (Figure 3.2)
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Attaching the Rail Supports to the Rear Rack Rails

Attach the rail supports to the rear rack rails as shown in Figure 3.3.

Figure 3.3  Example of Attaching Rail Supports to the Rear Rack Rails

Mounting the pro-xi 100 System in the Rack 

To mount the pro-xi 100 system in the rack

1. Lift the pro-xi 100 system into place.

2. Slide the rail extensions into the rail supports.

3. Secure the pro-xi 100 chassis to the rack with four standard rack bolts and nuts.

Caution — The pro-xi 100 system weighs approximately 42 pounds (19kg). Two people should work 
together to lift it into place to avoid physical injury.
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Figure 3.4  Example of Attaching the pro-xi 100 System to a Rack
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Cabling
This chapter provides interconnect diagrams and examples of how to cable single-head and dual-head setups.

Before You Begin

Keep the following in mind when cabling your system:

• If the connected computer systems output a VGA video signal, a VGA-to-DVI-I adapter is required. 

• If the connected computer system outputs an HDMI video signal, an HDMI-to-DVI-D adapter is required.

• If the pro-xi 100 outputs are connected to HDMI monitors or KVM TX units that utilize HDMI, then the 
appropriate cable or adapter is required.

Direct Keyboard and Mouse

Figure 4.5 illustrates an operator station with a direct keyboard and mouse connection to the pro-xi 100 system.

Figure 4.5  Operator Station — Direct Keyboard and Mouse

Single-Head Direct Monitor

Figure 4.6 illustrates an operator station with a direct monitor connection to the pro-xi 100 system.

Figure 4.6  Operator Station — Single-Head Direct Monitor
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Dual-Head Direct Monitor

Figure 4.7 illustrates an operator dual-head station with a direct connections to the pro-xi 100 system.

Figure 4.7  Operator Station — Dual-Head Monitors

Single Output (Single-Head) Direct Keyboard, Video, and Mouse

Figure 4.8 illustrates the cabling required to connect a computer system to the pro-xi 100 system.

Figure 4.8  Single Output, Single-Head Connections
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Dual Output (Dual-Head) Direct Keyboard, Video, and Mouse

Figure 4.9 illustrates the cabling required to connect a computer system to the pro-xi 100 system.

Figure 4.9  Dual Output, Dual-Head Connections

Interconnect, Single-Head Operator Station KVM Extender

Figure 4.10 illustrates a single-head operator station with the pro-xi 100 system and KVM Extenders.

Figure 4.10  Operator Station — Single-Head with KVM Extender
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Interconnect, Dual-Head Operator Station KVM Extender

Figure 4.11 illustrates a dual-head operator station with the pro-xi 100 system and two KVM Extenders.

Figure 4.11  Operator Station — Dual-Head with KVM Extender
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Single Video (Single-Head) KVM Extender

Figure 4.12 illustrates a single video operator station with the pro-xi 100 system and two KVM Extenders.

Figure 4.12  Operator Station — Single Output (Single-Head) with KVM Extenders
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Dual Output (Dual-Head) Using Single-Head KVM Extenders

Figure 4.13 illustrates a dual video output station with the pro-xi 100 system and two KVM Extenders.

Figure 4.13  ISC Interconnect — Dual Output (Dual-Head) with Single-Head KVM Extenders (2 Pairs)
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Dual Output (Dual-Head) Using Dual-Head KVM Extenders

Figure 4.14 illustrates a dual video output station with the pro-xi 100 system and two dual-head KVM Extenders.

Figure 4.14  ISC Interconnect — Dual Output (Dual-Head) with Dual-Head KVM Extenders (1 Pair)
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Initial Startup Display
This chapter describes the initial pro-xi 100 system display window areas and features.

Display Screen

After the pro-xi 100 system has completed its boot-up and initialization, and the background wallpaper has been 
loaded, the system will be at its initial display, as shown in Figure 5.1.

Figure 5.1  Example of the Initial Startup Display

Connected Systems

The connected computer systems will be arranged using the pro-xi 100 system’s initial layout, starting from the left 
side at the top of the display and finishing at the bottom of the right side of the display. In Figure 5.1, there are six 
single-head connected systems and one dual-head connected system, where the left and right displays of the 
dual-head system are joined together.

At this point, none of the connected computer systems are “active”, or under control of the Operator, and the 
Operator can move the pro-xi 100 cursor about the display and can move, resize and take control of any of the 
connected computer systems.

Work Area

This layout also creates a default “work area” in the lower-left portion of the screen that is used to take control of 
one connected computer system while still being able to view all other systems. The work area size is dynamically 
calculated, so if the Operator moves connected system windows away from (or into) this area, the new work area 
size will be enlarged or reduced based on the location of all connected computer system windows.
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Real-Time Clock

If the pro-xi 100 system was configured to display a real-time clock, it will be displayed as well, but may be 
covered up by the initial layout if it was placed at the top of the screen. In Figure 5.1, the real-time clock is shown 
in the smallest font size and placed at the “bottom-center” location.

Dual VOC Output

If the pro-xi 100 system has been configured for dual VOC output cards, the second display will also be active, 
although no connected computer systems will be seen: 

Figure 5.2  Example of the First Display Figure 5.3  Example of a Second Display
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Connected System Windows
This chapter outlines how to move a window and resize a window.

Moving a Window

 It is possible to move a window so that most of it is above the top of the display. If the cursor is released at this 
location, it will be difficult to move it back onto the display. Press F1 to restore all windows to their original 
position.

To move a single window

1. Move the cursor to the window and single-click it.

When a window is selected, the frame color around the window will change color to indicate it's been selected.

2. Move the cursor to the top area of the window until the cursor changes shape to the “move” cursor.

3. Hold down the left mouse button.

4. Drag the window to the new location.

To move a dual-head window

1. Position the cursor across the top of either the left or right display.

2. Single-click the window.

3. Drag the window.

Both windows are attached to each other and will move at the same time.

Resizing a Window

Keep the following in mind when resizing a window:

• Window sizes may be reduced from 1/8 the original size up to 8X the original size, or until the window size 
reaches the maximum input width of an ISC card.

• As the windows are resized, the connected system's original display aspect ratio is preserved.

• When sizing a dual-head window, position the cursor at the lower-right corner of the right display, and then drag. 
Both windows are attached to each other and will be resized at the same time.

To resize a connected system window

1. Selected the window by moving the cursor to the window and single-clicking it.

2. Move the cursor to the lower-right corner of the window until the cursor changes shape to the “resize” cursor.
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3. Hold down the left mouse button on the mouse.

4. Drag the window corner to increase or decrease the size of the window.

The upper-left corner of the window will remain “pinned” in the same location as the window is resized:
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Controlling Connected Systems
Taking control of connected computer systems is the primary function of the pro-xi 100 system, and there are a 
variety of ways for the Operator to accomplish this operation:

• Using the mouse to take control, leaving the window at the same size and location.

• Using the mouse to take control, filling the work area or the screen with the window as it is activated.

• Using the keyboard to step through all windows and take control, filling the work area or the screen with each 
window as they are activated.

• Using the keyboard to select a specific window to control, filling the work area or the screen as it is activated.

When a connected computer system is made active, all mouse and keyboard signals are routed to the connected 
system, and the system's audio (if connected) is routed to the pro-xi 100 system’s audio output. In addition, the 
window's frame color will change to the “active” color, indicating that the window is now active and responding to 
both mouse and keyboard data.

Mouse Control with No Size or Position Changes

To take control of a connected computer system without changing its window size or location, first select the 
window and then double-click the window to take control. The active window is highlighted as shown in Figure 
7.1.

Figure 7.1  Example of Active Window in Mouse Control

Mouse Control, Filling the Work Area

To take control of a connected computer system while filling the work area with window, first select the window 
and then hold down the CTRL button while double-clicking the window to take control. The active window is 
highlighted and fills the work area as shown in Figure 7.2.
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Figure 7.2  Example of Active Window Filling the Work Area

Mouse Control, Filling the Screen

To take control of a connected computer system while filling the screen, first select the window and then hold down 
the SHIFT + CTRL buttons while double-clicking the window to take control. The active window is highlighted and 
fills the screen as shown in Figure 7.3.

Figure 7.3  Example of Active Window Filling the Work Area

When sizing windows to fill the screen, the connected computer system’s display aspect ratio is used to calculate 
and size the window as large as possible while still maintaining the aspect ratio. In some cases this may cause the 
active window to fill the screen vertically but not horizontally (Figure 7.3), or horizontally but not vertically 
(Figure 7.4).

If the connected computer system’s aspect ratio matches that of the pro-xi 100 outputs, the screen will be 
completely filled (Figure 7.5). 
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Control of Dual-Head Connected Systems

When taking control of a dual-head connected system, there are slight differences in behavior when making them 
active to fill the work area or the screen.

When making a dual-head system active without changing the size or position, the system behaves as before, with 
the dual-head window being highlighted in the active color, no change in size or position (Figure 7.6), and nothing 
appearing on the right display (Figure 7.7).

When making a dual-head system active to fill the work area, the dual-head window is highlighted in the active 
color, both left and right display windows are positioned in the work area (Figure 7.8), and nothing appears on the 
right display (Figure 7.9).

Figure 7.4  Example of the Selected Display (Horizontal) Figure 7.5  Example of the Active Display (Filled)

Figure 7.6  Example of the Selected Display Figure 7.7  Example of the Right Display

Figure 7.8  Example of the Selected Display Figure 7.9  Example of the Right Display
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When making a dual-head system active to fill the screen, the left and right displays are shown on their respective 
outputs. (Figure 7.10)

Keyboard Control, Carousel Operation

Connected systems can also be accessed by rapidly activating them in a circular, round-robin, “carousel” fashion. 
To carousel from one system to the next, hold down the SHIFT + CTRL keys and press the space bar.

Each time the space bar is pressed, the next system is activated and will fill the work area. (Figure 7.11)

In Figure 7.11, each time the SHIFT + CTRL + space bar is pressed, the pro-xi 100 system rapidly switches from 
the connected system on ISC4 to ISC5 and then to ISC6. Each time the connected system is made active, it fills the 
work area.

Figure 7.10  Example of Dual-Active Screen (Left and Right Outputs)

Figure 7.11  Example of Carousel Displays
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In some cases, the Operator may want to carousel from one system to the next, but needs the connected systems to 
be larger than the work area. To carousel from one system to the next while filling an area larger than the work area, 
hold down SHIFT + CTRL + ALT and press the space bar.

Each time the space bar is pressed, the next system is activated and will fill a percentage of the screen. (Figure 
7.12)

In Figure 7.12, each time the SHIFT + CTRL + ALT + space bar is pressed, the pro-xi 100 system rapidly switches 
from the connected system on ISC4 to ISC5 and then to ISC6. Each time the connected system is made active, it 
fills a percentage of the screen, which allows the active system to overlap the other connected systems.

Adjusting the Size

You can adjust the size (or percentage of the workspace filled) of the connected systems, so when you carousel 
through them, and activate them, the activated system fills a greater/lesser percentage of the screen. This can be 
done from almost any layout whether you have a controlled window open or not.

To increase the size of a connected system window

1. Press and hold SHIFT + CTRL + ALT.

2. Click the right arrow until you arrive at your desired window size.

3. Carousel through the connected systems by pressing and holding SHIFT + CTRL + ALT and then pressing the 
space bar.

The percentage of the workspace filled with each activated window increased.

To decrease the size of a connected system window

1. Press and hold SHIFT + CTRL + ALT.

2. Click the left arrow until you arrive at your desired window size.

Figure 7.12  Example of Using the Carousel Function
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3. Carousel through the connected systems by pressing and holding SHIFT + CTRL + ALT and then pressing the 
space bar.

The percentage of the workspace filled with each activated window decreased.

Keyboard Control, Keypad Selection

The keypad on the pro-xi 100 system’s keyboard can also be used to instantly activate any connected system.

To activate a specific input computer

1. Press and hold SHIFT + CTRL.

2. Press any key on the numeric keypad (1-8) to activate a specific computer and fill the available workspace.

To close the currently active system using the keypad

1. Press and hold SHIFT + CTRL.

2. Perform one of the following:

• Press the number 0.

• Press ESC.

To close the currently active system using a mouse

1. Press and hold SHIFT.

2. Right-click the mouse.
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Creating and Using Sub-windows
Sub-windows allow the Operator to create a second window for each of the connected computer systems. The 
sub-window can be the same size and shape as the original, or the Operator can choose to create a rectangular 
window spanning any area of the parent window.

Once a sub-window has been created, it behaves like any other window in the pro-xi 100 system — it can be moved 
anywhere on the display, resized (larger or smaller), and can also be saved as part of a layout. Sub-windows can 
have any rectangular shape.

Sub-windows can be used to perform a variety of tasks, including:

• Mark a small area of text to be enlarged so it is visible from across the room.

• Highlight a widget, progress bar or other indicator for easier viewing.

• Focus in on any part of the computer display - even a computers Status Bar or icon tray.

• Enlarge a digital control, readout or clock for greater visibility.

• Focus on a specific region of a movie, security camera video or any streaming content.

 Each main window supports one sub-window. If a sub-window already exists when a new sub-window is 
created, the old sub-window is automatically deleted.

Creating a Sub-window

To create a sub-window

1. Position the pro-xi 100 cursor to the upper-left corner of the area on the main window that will form the 
sub-window.

In the following example, the Operator wants to create a sub-window for the Firefox® and firewall icons.

2. Hold down the right mouse button (the cross-hair cursor will appear) and drag the semi-transparent 
sub-window overlay to cover the area for the sub-window (as shown below).

 If the position of the sub-window is not correct, release the right mouse button. The cross-hair cursor and 
sub-window overlay will disappear, giving the Operator the option to try again.
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3. When the sub-window overlay is positioned and sized correctly, hold down the CTRL key when releasing the 
right mouse button to create the sub-window (as shown below).

When the new sub-window is created, it will be positioned in the center of the display and is ready for the Operator 
to move and/or resize it. Sub-windows can be created in any rectangular size. The example above shows a 
sub-window that is wider than it is tall, but sub-windows can also be created that are vertically oriented.

Figure 8.1  Sub-window Example — Vertically Oriented

In Figure 8.1, the Operator is creating a vertical sub-window to focus on a section of a menu. The resulting 
sub-window, after resizing, is shown in Figure 8.2.

Figure 8.2  Sub-window Example — Resized
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Moving, Resizing, and Panning Sub-windows

Once the sub-window has been created, it can be moved and resized like any other connected computer system 
window. Select the sub-window, and then position the cursor at the top of the window to move it, or at the 
lower-right corner to resize it.

Sometimes when the sub-window is created, the size is correct but the window content just needs to be “nudged” 
slightly in one or both directions for optimal coverage. Figure 8.3 shows a sub-window that's been created and 
enlarged before panning.

Figure 8.3  Sub-window Example

To pan the underlying display content of a sub-window, select the sub-window and hold down the left mouse button 
and drag the image around inside the sub-window until it is positioned correctly. Figure 8.4 shows the sub-window 
from above after it was panned downwards.

Figure 8.4  Sub-window Example — Panned to the Right

Creating a Cloned Sub-window

In some cases, the Operator may need to create a copy of a main window that's the same size as the original. To 
create a sub-window that's an exact copy of a main window, click on the main window to select it and then hold 
down the GUI (the left Start button on your keyboard) and press C.

When a cloned sub-window is created, it is not positioned in the middle of the display. Instead, it is positioned 
adjacent to the main window it was cloned from.

Deleting Sub-windows

To delete a sub-window, select it and then double right-click on it.
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Creating and Using Layouts
Layouts provide an easy way for the Operator to save the current display organization of all connected system 
windows (including any sub-windows) for later single-key recall.

Creating a Layout

When a layout is saved, the location on the screen of each window, along with the size and whether or not the 
window is hidden, is stored into one of th 11 available storage locations. Each of these storage locations are 
accessed by hitting one of the 12 function keys.

 The layout on F1 is reserved to hold the default system layout, and cannot be overwritten with another layout.

To save a layout using one of the function keys

1. Press and hold down the SHIFT key.

2. Press any of the functions keys (F2 - F12).

The current screen organization will be saved to that function key.

The layout stored on F1 will always restore the initial pro-xi 100 system layout. (Figure 9.1)

Figure 9.1  Example of Restored Layout

Using Layouts

Layouts allow the Operator to save the size and position of all connected system windows. Figure 9.2 shows 
another layout, where all eight of the connected systems have been organized to be shown as large as possible.

Figure 9.2  Example of a Layout with Eight Connected Systems
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As mentioned before, both the main connected system windows and any sub-windows are saved in the layout. 
Figure 9.3 all eight sub-windows have been created on top of their associated main windows.

Figure 9.3  Example of a Layout with Eight Connected Systems with Sub-windows

Finally, when a second VOC as installed in the pro-xi 100 system, layouts can span both displays. (Figure 9.4) 

  
Figure 9.4  Example of Second VOC and Dual Displays

 To recall a layout, press the corresponding function key (F1 - F12).
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System Menus
This chapter summarizes the system menus for your pro-xi 100 system.

Status Bar Overview

The Status Bar is used to gain access to the pro-xi 100 system menu operations. When the Status Bar is displayed, 
the Operator can open menus to:

• Display system health

• Perform firmware, gateware, and software upgrades

• Format USB drives for use in changing configurations

• Shutdown or reboot the pro-xi 100 system

Using the Status Bar

While the Status Bar is displayed and the pro-xi 100 system is in menu mode, the Operator will not be able to 
take control of any system.

To reveal the Status Bar

1. Press the ESC key on the keyboard to put the pro-xi 100 system into “menu” mode.

2. Press the ESC key again will take the system out of menu mode and remove the Status Bar.

Depending on how the Status Bar options have been configured, when the Status Bar is revealed it may appear on 
the top of the screen or the bottom. It may pop in, fade in, or slide in depending on its animation setting.

Once the Status Bar has been revealed, it will stretch across the entire length of the display, regardless of the VOC 
output width setting. The Status Bar contains four icons and is shown below:

Figure 10.1  Example of a Revealed Status Bar

Clicking on one of the icons will open up the menu for that operation. Since the menus are “modal”, the selected 
operation must be completed or the Operator must click Close before starting the operation. Only after the menu 
has been closed will the Operator be able to press the ESC key to remove the Status Bar and return to being able to 
control the connected systems.

Health Menu

The health menu provides a complete listing of all health-related system components, including voltages, 
temperatures, fan speeds and the status of the AC power supplies and their inputs.

These values are presented in a familiar spreadsheet format with the rear panel and the various cards organized into 
columns, and the health components being organized into rows. (Figure 10.2)
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Figure 10.2  Example of a Health Menu

A detail of the left side of the Health Menu showing the monitored health components is shown in Figure 10.3.

Figure 10.3  Example of a Health Menu — Left Pane

Using the Health Menu

When the menu is first displayed, a snapshot of all health components is displayed. The Operator can click Refresh 
button at any time to recover a new snapshot, which will be immediately displayed.

The Operator can click Close to remove the menu.

Upgrade Menu

The upgrade menu is used to update the firmware, gateware and software in the pro-xi 100 system, providing 
Operators new features and enhancements.

When a new release is available, it will be posted on the Ross Video website. The designated personnel at your 
company will be given login credentials to access and download the new updates.

Each new release will include instructions on how to install it, including which Upgrade Options boxes to check. 
These options are used to specify which new upgrade components are to be “burned” into the pro-xi 100 system, 
installing them permanently in the system's non-volatile memory.

Performing an Upgrade 

When the upgrade icon is clicked on the Status Bar, the Upgrade Menu will be displayed (Figure 10.4).
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Figure 10.4  Example of an Upgrade Menu

The Upgrade Options section to the left allows the Operator to specify which upgrade options are to be performed. 
The status area on the right shows the progress of the upgrade operation.

Selecting the Upgrade Options 

After installing the new proxi-app and using it to export the new firmware, gateware, and software files to the pro-xi 
100 system, the Software Release Notes will contain step-by-step instructions on how to perform the upgrade - 
including which Upgrade Options boxes to select.

Figure 10.5  Example of Selecting the Upgrade Options

In Figure 10.5, options have been checked to install a new Operating System on the BPA, ISC, VOC and CTC card, 
and to verify the installation after the burn.

 It is recommended that the Verify After Burn option be selected every time new firmware, gateware or software 
upgrades are installed.

Starting the Upgrade Operation

Once the applicable Upgrade Options are selected, click Start to begin the upgrade operation.

Figure 10.6  Example of Confirm Upgrade Operation Dialog

As shown in Figure 10.6, the system will display a confirmation menu that provides the Operator one last chance to 
exit the upgrade operation before it starts. Click OK to start the upgrade operation.
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Keep the following in mind when upgrading your pro-xi 100 system:

• Before beginning the upgrade process, make sure there is reliable power available for the upgrade operation, 
which may take as long as 50 minutes. The use of an Uninterrupted Power Supply (UPS) is highly 
recommended. 

• During the upgrade procedure, the pro-xi 100 system will be unavailable for normal operations.

Status Displayed During the Upgrade Operation 

During the upgrade operation, status information will be displayed for each card, as shown in Figure 10.7.

Figure 10.7  Example of the Upgrade Status Dialog

Status information will include:

• downloading of specific files

• downloaded file validation

• non-volatile memory erase operations

• non-volatile memory burn operations

• burn verification

 It is important to maintain power to the pro-xi 100 system and avoid interfering with the system during the 
upgrade.

Completion of the Upgrade Operation 

Once the upgrade operation is completed, the status area will report the success of the operation for each of the 
cards in the pro-xi 100 system, as shown in Figure 10.8.

Figure 10.8  Example of the Completed Upgrade Message

If all cards report success, then the Upgrade dialog can be closed and the system can be rebooted for the new 
upgrades to take effect. The Operator can also choose to continue normal operations (using the existing firmware, 
gateware, and software) and reboot at a later time.

Notice — If power is lost during the upgrade process, the pro-xi 100 system may become inoperative and need to be 
returned to the factory to be restored.
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 You must reboot the pro-xi 100 system for the new features and capabilities to be available, and to remove the 
previous version.

USB Format Menu

The pro-xi 100 system utilizes USB memory devices in a number of ways:

• To copy files to the pro-xi 100 system from other computer systems

• As a rescue-recovery device to restore the pro-xi 100 system

• To store different configurations that the pro-xi 100 system can boot from

In each of these cases, the USB memory device must first be formatted to a file-system structure that is compatible 
with the pro-xi 100 system. The USB Format menu is used for this purpose.

To format a USB device for use in the pro-xi 100 system

1. Click the USB icon on the Status Bar.

The USB Drive Format menu opens.

2. Insert a USB device into the bottom USB slot on the back of the pro-xi 100 system.

 The USB device should not be any larger than 8GB in size.

3. Click Format.

If the USB device is too large, or no USB device is detected, an error message is displayed, as shown below.

4. When the USB device is detected, the format operation will begin.

Depending on the size of the USB device, the format operation may take several minutes to complete. During 
the format operation, the following message is displayed.

5. Once the format operation is complete the USB device can be removed from the pro-xi 100 system.

6. Click Close to exit the USB Drive Format menu.
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System Reboot/Shutdown Menu

The System Reboot / Shutdown menu is used to safely power-down the pro-xi 100 system. This is required to make 
sure the system preserves its operating environment, logs, system settings and other dynamic components prior to 
disconnecting power. 

Rebooting the pro-xi 100 System

Click the Shutdown icon on the Status Bar to display the System Reboot / Shutdown menu (Figure 10.9).

Figure 10.9  System Reboot/Shutdown Dialog.

When the menu is first displayed, the Reboot option will be selected. After new firmware, gateware, and software 
upgrades are installed, the pro-xi 100 system needs to be rebooted. To do this, click Reboot. As the system is shut 
down, the dialog will display a number of status items:

• Closing configuration manager

• Disabling logging

• Saving system logs

• Sending shutdown notifications

• Waiting for files to be written

• Terminating psmfm

• Setting eUSB to safe mode

• Unmounting the eUSB drive

• eUSB unmounted

• System halted — safe to disconnect power!

Once the last item is displayed, the pro-xi 100 system will begin the reboot sequence. This is characterized by the 
system fans all spinning up to maximum cooling capability.

Shutting Down the pro-xi 100 System 

Prior to disconnecting power to the pro-xi 100 system, it needs to be shut down.

Notice — If power is disconnected from the pro-xi 100 system before it is safely shutdown, it may become 
inoperative and need to be returned to the factory to be restored.
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To shut down the pro-xi 100 system

1. From the System Reboot/Shutdown menu, select Shutdown the pro-xi system.

2. Click Shutdown.

3. As the system is shut down, the dialog displays the same status items as when the system is being rebooted. 

4. Once the shutdown sequence is complete, the system will indicate that it is safe to disconnect power.
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Installing the proxi-app Utility
The proxi-app utility can be installed on any computer system running the Microsoft® Windows® XP, Windows® 
Vista, Windows® 7, Windows® 8, and Windows® 10 operating systems.

 After the installation is complete you can launch the proxi-app utility and utilize it to create or edit configurations 
for your pro-xi 100 system. Refer to “Creating a New Configuration” on page 55 for additional information.

To install the proxi-app utility

1. Navigate to the Ross Video website and download the latest install file.

2. Copy the downloaded install file it to a known location on your computer system.

3. Double-click the install file to execute it.

The Setup proxi-app dialog opens.

4. Click Next.

5. On the License Agreement dialog, review the text and click Next to continue the installation.

6. Use the Destination Location dialog to choose a location on your system to install the proxi-app utility.

We recommend using the default setting to remain compatible with future versions of this utility.

7. Click Next to accept the specified destination location and continue the installation.

8. If required, use the Start Menu Folder dialog to name your desktop shortcut to something other than proxi-app 
utility.

9. Click Next to accept the specified shortcut name and continue the installation.

10. On the Additional Tasks dialog, selecting the Create a desktop will add the proxi-app shortcut icon to your 
desktop during installation.
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11. Click Next to continue the installation.

12. Use the Ready to Install dialog to confirm the selections you made during the installation wizard.

13. Click Next when you are ready to start the software installation.

14. Use the Installation Progress dialog to monitor the installation.

During software installation, cursor files, font files, FPGA binary files, Linux® operating system binary files, 
and wallpaper images are copied over to your system.

15. Once the installation has completed:

a. Leave the Launch proxi-app box selected.

b. Click Finish to exit the software installation.
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Creating a New Configuration
After installing the proxi-app utility in the previous chapter, you can now launch the utility and utilize it to create or 
edit configurations for your pro-xi 100 system.

Launching the proxi-app Utility

To launch the proxi-app utility

1. Locate the  icon on the Microsoft® Windows® desktop.

2. Double-click the icon to display the proxi-app dialog.

Creating a New Configuration

The process of creating a new configuration involves:

• Enabling the video output card(s) and specifying the output resolution for the pro-xi 100 system

• Enabling the input system card(s) and selecting their video sources and resolutions

• Specifying the network parameters (such as its IP address and netmask) for the pro-xi 100 system

• Exporting the configuration to the pro-xi 100 across the network or with a USB drive

To create a new pro-xi 100 system configuration

• Click File > New.

The new configuration will be created, loaded, and displayed in the card inventory list:
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The card inventory list shows configuration information for each card that can be installed into a pro-xi 100 system. 
The first column contains icons indicating the associated card's status: 

The second column displays the card's abbreviated ID, and the third column displays the card's functional name. 
The fourth column displays the card's input video source and resolution, while the fifth column displays the card's 
label - which is the text displayed in the frame surrounding the card's primary and sub windows. Finally, the sixth 
column displays information regarding the card's current status.

Configuring the Video Output Cards (VOC)

The first step in creating a new configuration is to enable the VOC card(s) and select a video output resolution.

Every pro-xi 100 system has one Video Output Card (VOC) installed, and a second VOC card can be added as an 
option to provide dual-screen, dual-head and dual-operator capabilities. The VOC card provides a DVI output 
(single-link or dual-link, depending on the selected video resolution) that connects to the Operator's computer 
displays using standard DVI cables.

To configure the VOC cards

1. Double-click the VOC1 or VOC2 entry in the card list.

The VOC Configuration dialog opens.

 Because every pro-xi 100 system requires at least one VOC card, the Enable Device box will always be selected 
for VOC1, and cannot be cleared.

2. To enable a second VOC card, click Enable Device.

3. Once the VOC card(s) are enabled, the output resolution must be selected. Refer to “Technical Specifications” 
on page 109 for a list of all supported input and output resolutions.

Table 12.1  Card Status Icons

Icon Description

Card is enabled and operational

Card is disabled

Card is enabled, but has operational issues

Card is enabled, but has experienced errors
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 If two VOC cards are installed and enabled in a system, changing the output resolution on one VOC card will 
automatically set the other VOC card to the same resolution.

4. If two VOC cards are installed in the system, configure the video output. Choose from the following:

• Mirror — In this mode, the video feeding the left monitor from VOC1 is simply mirrored over on VOC2.

 

• Side by Side — In this mode, VOC1 feeds the left display and VOC2 feeds the right display. The video 
canvas stretches across both monitors horizontally, giving the Operator a wide area to work in.

  

• Over/Under — In this mode, VOC1 feeds the upper monitor and VOC2 feeds the lower monitor. The video 
canvas stretches across both monitors vertically, giving the Operator a tall area to work in.

 

5. Verify that:

• the VOC card is enabled, 
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• the output resolution selected, and

• the monitor configuration is set.

6. Click OK to accept the new VOC settings. 

Configuring the Input System Cards (ISC)

The second step in creating a new configuration is to enable each ISC card, select its input video source, system 
type, input resolution options, and provide a system label.

EDID Support

The pro-xi 100 system supports the Extended Display Identification Data (EDID) protocol. Each ISC card in the 
pro-xi 100 system appears to the external computer system as just another monitor, and just like a monitor will 
provide an EDID data block to the computer system that describes the video parameters it supports.

If auto-res is enabled, then the resolution selected in the drop-down list will appear in the EDID information as the 
'preferred' resolution to be used, even though the ISC card will lock to any input resolution. This preferred 
resolution in the EDID table will help the external computer system to run at the desired resolution.

If auto-res is not enabled, then the resolution selected in the drop-down list appears in the EDID information as the 
preferred resolution, as well as being the only resolution the ISC card will lock to.

Configuring the ISC Cards

Every pro-xi 100 system has at least two Input System Cards (ISC) installed. The ISC cards provide the interface to 
the external computer system or KVM receiver that is to be controlled and accessed by the pro-xi 100 system. The 
external computer system is connected to the ISC card using:

• DVI video is connected directly to the ISC’s DVI video connector

• HDMI video is connected through an inexpensive HDMI-to-DVI adapter to the ISC’s DVI video connector

• VGA video is connected through an inexpensive VGA-to-DVI adapter to the ISC’s DVI video connector

• Keyboard and mouse are connected using USB A/B cables

• Stereo audio is connected using 3.5mm stereo audio cables

To configure the ISC cards

1. Double-click the ISC entry in the card inventory list to be configured. 

The ISC Configuration dialog opens.

2. To enable the ISC card, click Enable Device.

3. Use the Device Label to assign a name or ID that uniquely identifies the system that will be connected to this 
ISC. This label will appear on the pro-xi 100 system’s screen in the frame that surrounds the system, making it 
easy to know which system is which. If the name is not known at this time, you can leave it as undefined, 
change it to input #1, etc.

4. Select the video input source.

The ISC video input can be from a DVI source, or from an HDMI or VGA source through inexpensive 
adapters. If the input source is known and will not change often, select the DVI option for DVI or HDMI input 
sources, or VGA for analog VGA sources. The pro-xi 100 system can also auto-sense which kind of video 
source is present, and selecting Auto-Sense enables this feature - and is the recommended setting for this 
feature.

5. Select the input resolution.

Notice — Do not enable a VOC card that is not installed in your system or the pro-xi 100 system may not operate 
properly.
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Just like the auto-sense feature, the pro-xi 100 system can detect the input video resolution and automatically 
lock to it. This feature is enabled by selecting Enable Auto-Res. If left unselected, the input resolution is 
selected from the drop-down list, and will be the only resolution that will be locked to. Selecting Enable 
Auto-Res is the recommended setting for this feature.

6. Select the input type. The input type describes the kind of external computer system being connected to the 
pro-xi 100 system. Choose from the following:

• System — This option is used when connecting an external computer system with a single video output. 
This is the most common option.

• Dual-Head System - Left Display — This option is used when connecting an external computer system 
that has dual outputs, and the ISC card is being connected to the left display.

• Dual-Head System - Right Display — This option is used when connecting an external computer system 
that has dual outputs, and the ISC card is being connected to the right display.

• Static Image — This option is used to display a static image on the ISC card. When this option is selected, 
no input video from the external system will be seen; instead the Browse button is enabled and the user can 
select a standard BMP image file.

7. After the ISC card has been enabled, its label entered, its input source and input resolution selected, and the 
input type is set, click OK to accept the new ISC settings.

8. Repeat these steps for each of the ISC cards installed in your system. 

Specifying the Network Settings

The third step in creating a new configuration is to specify the systems network parameters, such as IP address, 
netmask, gateway, etc.

The pro-xi 100 system does not require a network connection for normal operation, so this step is optional. 
However, being able to transfer updated configurations, software updates, license files, etc. across the network is 
the easiest and most efficient way of updating the pro-xi 100 system. In addition, a network connection provides 
additional capabilities:

• Existing configurations can be imported from the of the pro-xi 100 system, and configurations can be moved 
from one system to another.

• Product information and build data can be retrieved and displayed

• The inventory of the pro-xi 100 system can be retrieved and displayed

• The real-time clock of the pro-xi 100 system can be set and adjusted.

• System status reports can be retrieved for troubleshooting and remote diagnostics.

To configure the network settings

1. Click Settings > Network.

The Network Settings dialog opens.

Notice — Do not enable an ISC card that is not installed in your system or the pro-xi 100 system may not operate 
properly.
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2. Enter the IP address and netmask for the pro-xi 100 system in their associated fields.

These are the only two fields that are required for proper network operation.

3. If you have the IP addresses for the network gateway, DNS name servers and a preferred host name, they can 
also be entered here.

4. Once the required IP address and netmask fields have been set, as well as any of the optional fields, click OK to 
accept the new network settings.

Saving the New Configuration

After configuring the VOC and ISC cards, the card inventory list should look similar to Figure 12.1.

Figure 12.1  Example of a Valid Configuration List

To save this configuration

1. Click File > Save As….

The File dialog opens.

2. Enter a filename to assign to the configuration.

3. Click OK.

You are now ready to export the configuration to the pro-xi 100 system. If this is the first time a configuration is 
exported to the pro-xi 100 system (or the system is not connected to the network), then follow the instructions found 
in “Exporting a Configuration via USB” on page 63.

If the pro-xi 100 system is connected to the network, you can more easily and efficiently export the configuration 
following the instructions found in “Exporting a Configuration Across the Network” on page 67.

If you want to test the new configuration before exporting it, follow the instructions in “Testing a Configuration 
Using a USB Drive” on page 61.
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Testing a Configuration Using a 
USB Drive
This chapter describes how to format and create a USB drive that can be used to export the pro-xi 100 system.

Before You Begin

When the pro-xi 100 system boots at power-up, it normally utilizes an internal USB drive that holds all the files 
needed for the system to operate:

• The system configuration file

• The video resolutions file

• Cursors, fonts, skins and sound files

• Images used on ISC cards

• Background wallpaper

When a configuration is exported to the pro-xi 100 system, the various configuration files are written to the internal 
USB drive, and then when the system is rebooted, it utilizes the new files.

However, it is also possible to boot the pro-xi 100 system using an external USB drive that has been written with 
these same files. When the pro-xi 100 system boots, it first looks to see if there is an external USB drive inserted 
into the system; if one is found, it boots using this USB drive rather than the internal USB drive. In this manner, 
new configurations can be created, written to a USB drive, and tested without altering the original configuration 
information written to the internal USB drive of the pro-xi 100 system. If the configuration is faulty for whatever 
reason, simply removing the USB drive and re-booting the pro-xi 100 system will restore the original configuration.

After the configuration has been tested, it can be exported to the pro-xi 100 system using a USB drive (see 
“Exporting a Configuration via USB” on page 63) or across the network (see “Exporting a Configuration 
Across the Network” on page 67).

Formating and Creating a Bootable USB Drive

To create a bootable USB drive, it must first be formatted with the FAT16 file system.

To format a USB drive

1. Insert a USB drive that is 8GB or less in size into any Microsoft® Windows® XP, Windows® Vista, 
Windows® 7, Windows® 8, or Windows® 10 system.

2. Once the drive appears in the dialog, right-click it.

3. Click Format… to display the Windows® Format menu.

4. Make sure that FAT is selected for the file system.

5. Click Start to begin the formatting operation.

To create a bootable USB drive

1. Click File > Open.

2. Select the configuration you wish to export to the bootable USB drive.

3. Click Export > Create Bootable USB Drive.

4. Select the drive (formatted in the previous procedure “To format a USB drive”) from the list:

5. Select the formatted USB drive.

6. Click OK.
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All necessary files will be copied to the USB drive and the Export Configuration Fileset status dialog opens.

 This operation will take a few minutes.

7. Once all files have been copied to the USB drive, the proxi-app utility dialog opens to indicate the USB drive 
has been created.

8. Eject the USB drive to ensure all files are written to the drive before removal:

a. Return to the Microsoft Windows drive listing.

b. Select the bootable USB drive from the list.

c. Click Eject or Safely Remove Drive.

Insert the USB Drive

Before proceeding, ensure the pro-xi 100 system is powered down.

To power down the system

1. If the system is currently running, use the System Reboot / Shutdown menu, to execute a safe system 
shutdown. Refer to the section “System Reboot/Shutdown Menu” on page 50 for details.

2. After the pro-xi 100 system indicates it is safe to remove power, disconnect power to both AC inputs on the 
rear of the chassis.

To insert the USB Drive

1. Insert the USB drive into the CTC card in the USB3 slot, which is just above the Ethernet port.

2. Apply power to the pro-xi 100 system by connecting power to both inputs on the rear of the chassis.

Audio Out
Mouse/Keyboard

Mouse/Keyboard

USB Drive

Ethernet
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Exporting a Configuration via USB
This chapter outlines the process of using a USB drive to export a configuration to the pro-xi 100 system.

Before You Begin

Once a configuration is created or updated, it must be exported to the pro-xi 100 system. When exporting a 
configuration using a USB drive, the process involves writing the configuration onto a USB drive and then 
rebooting the pro-xi 100 system with the USB drive inserted in the system.

During the boot process, the pro-xi 100 system will detect the USB drive with the updated configuration has been 
inserted, and copy all configuration files over to the internal USB drive. After all files are copied, the USB drive is 
removed and the pro-xi 100 system is restarted to utilize the new configuration.

When exporting a configuration using a USB drive, the old configuration is over-written and replaced with the 
new one.

Formatting a USB Drive for Exporting

To create a USB drive for export, it must first be formatted with the FAT16 file system. 

To format a USB Drive for exporting

1. Insert a USB drive that is 8GB or less in size into any Microsoft® Windows® XP, Windows® Vista, 
Windows® 7, Windows® 8, or Windows® 10 system.

After a few moments, the USB drive will appear on the computer as a Removable Storage device. In some 
cases, Windows® will automatically install a device driver to support the USB drive.

2. Right-click on the USB drive.

3. Click Format to open the Format menu.

4. Make sure that FAT is selected for the file system.

5. If the Quick Format option is available, it can be selected to speed up the format operation. 

6. If required, specify a Volume Label to describe the USB device.
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7. Once the settings are selected, click Start to begin the formatting operation.

8. When the format operation is complete:

a. Click OK to close the Complete dialog.

b. Click Close to close the Format menu.

Creating a USB Drive for Exporting

To create a USB drive for export

1. Click File > Open.

2. Select the configuration you wish to export to the USB drive.

3. Click Export > Create Rescue USB Drive to display the USB Rescue Options dialog.

4. Select the Copy Files to System box.

5. Confirm that none of the boxes in the Burn Operations area are checked.

6. Click OK to accept these settings.

The Browse for Folder dialog opens.

7. Select the formatted USB drive.

8. Click OK.

All necessary files will be copied to the USB drive and the Export Configuration Fileset dialog opens.

 This operation will take several minutes.

9. Once all files have been copied to the USB drive, the proxi-app dialog opens to indicate the USB drive has 
been created.
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10. Eject the USB drive to ensure all files are written to the drive before removal:

a. Return to the Windows® drive listing.

b. Select the USB drive in the list.

c. Click Eject or Safely Remove Drive.

Inserting the USB Drive

Before proceeding, ensure the pro-xi 100 system is powered down.

To power down the system

1. If the system is currently running, use the System Reboot / Shutdown menu, to execute a safe system 
shutdown. Refer to the section “System Reboot/Shutdown Menu” on page 50 for details.

2. After the pro-xi 100 system indicates it is safe to remove power, disconnect power to both AC inputs on the 
rear of the chassis.

To insert the USB Drive

1. Insert the USB drive into the CTC card in the USB3 slot, which is just above the Ethernet port.

2. Apply power to the pro-xi 100 system by connecting power to both inputs on the rear of the chassis.

3. As the pro-xi 100 system boots, the boot screen will display.

4. At approximately the 40% point, the configuration copy operation will begin.

5. When the configuration copy operation is complete, the boot screen will indicate this status and prompt the 
user to remove the USB drive and reboot the pro-xi 100 system.

Audio Out
Mouse/Keyboard

Mouse/Keyboard

USB Drive

Ethernet
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6. Disconnect power to both AC inputs on the rear of the chassis.

7. Remove the USB drive. 

8. After the USB drive has been removed and power has been off for a minimum of 10 seconds, re-apply power to 
both AC inputs on the rear of the chassis.

The pro-xi 100 system will reboot using the updated configuration.
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Exporting a Configuration Across 
the Network
Once a configuration has been created or updated, it must be exported to the pro-xi 100 system. When exporting a 
configuration across the network, the process involves creating or opening a connection to the target pro-xi 100 
system, copying the files across the network, and then rebooting the pro-xi 100 system to use the updated 
configuration.

When exporting a configuration across the network, the old configuration is over-written and replaced with the 
new one.

Creating a Network Connection

The first step in exporting a configuration across the network is to create a network connection to the pro-xi 100 
system. If a network connection for the target pro-xi 100 system already exists, this step can be skipped and you can 
proceed to “Opening a Network Connection” on page 68.

 These steps only need to be done once, for each pro-xi 100 system in use. After the network connection entry has 
been created, the connection can now be opened.

To create a network connection

1. Click Connection… to open the Workstation Connection dialog.

2. Click New to open the Add Workstation dialog.

3. Enter the IP address assigned to the pro-xi 100 system in the IP Address control, and provide a label to make 
identifying the system easier.

4. Click OK to accept the settings.

The new network connection entry displays.
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Opening a Network Connection

 Before opening a network connection to a pro-xi 100 system, make sure it is powered on and has completed its 
boot-up operation.

To open a network connection

1. Ensure the pro-xi 100 system network connection has been created as outlined in the previous section.

2. Connect to the pro-xi 100 system by clicking on the entry in the list for the target pro-xi 100 system.

3. Click Connect.

4. If the network connection is successfully established, a green check-mark displays.

5. Once the network connection is established, proceed to “Exporting the Configuration”.

Exporting the Configuration

To export a configuration across the network

1. Click File > Open.

2. Select the configuration you wish to export. 

3. Click Export > Export fileset to remote system.

The Remote Export Options dialog opens.
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4. When exporting a new configuration, only the Export Configuration Files entry needs to be selected. 

5. If static images were selected for any of the ISC cards, the Export System Files entry should also be selected. 

6. Click OK to accept the settings and begin the export operation.

7. Use the Export Configuration Fileset dialog to monitor the export progress.

After the files are exported to the pro-xi 100 system, the Completion dialog opens.

8. Click OK to close the dialog.

9. Once the updated configuration is exported to the pro-xi 100 system, you must reboot the system so that it will 
utilize the updated configuration. To execute a safe system shutdown, refer to “System Reboot/Shutdown 
Menu” on page 50.

10. After the pro-xi 100 system indicates it is safe to remove power, disconnect power to both AC inputs on the 
rear of the chassis and wait a minimum of 10 seconds before re-connecting power to both AC inputs.

The pro-xi 100 system will reboot using the updated configuration.
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System Upgrades via a USB
The pro-xi 100 system is based on Field Programmable Gate Array (FPGA) technology, which means that not only 
can new software features be added in the field, but new hardware features can as well. The data used to initialize 
the FPGA devices are stored in non-volatile memory, and these memory devices also hold the Linux® operating 
system software images that drive and operate the pro-xi 100 system.

Before You Begin

During the boot process, the pro-xi 100 system will detect the USB drive with the system upgrades has been 
inserted, and will first copy all files and data over to the internal USB drive. After the copy operation is completed, 
the data and Linux images are burned into the non-volatile memory. Once these memory devices are updated, the 
pro-xi 100 system is restarted to utilize the new hardware and software upgrades.

Before beginning the upgrade process:

Make sure there is reliable power available for the 45-minute (approximate) upgrade time frame. The use of an 
Uninterrupted Power Supply (UPS) is highly recommended. 

 During the upgrade procedure, the pro-xi 100 system will be unavailable for normal operations.

Formatting a USB Drive for System Upgrades

To create a USB drive for export, it must first be formatted with the FAT16 file system. 

To format a USB Drive for exporting

1. Insert a USB drive that is 8GB or less in size into any Windows® XP, Windows® Vista, Windows® 7, 
Windows® 8, or Windows® 10 system.

After a few moments, the USB drive will appear on the computer as a Removable Storage device. In some 
cases, Windows® will automatically install a device driver to support the USB drive.

2. Right-click on the USB drive.

3. Click Format to display the Format menu.

4. Make sure that FAT is selected for the file system.

5. If the Quick Format option is available, it can be selected to speed up the format operation. 

6. If required, specify a Volume Label to describe the USB device.

7. Once the settings have been selected, click Start to begin the formatting operation.

8. When the format operation is complete:

a. Click OK to close the Complete dialog.

b. Click Close to close the Format menu.

Creating a USB Drive for System Upgrades

The procedure for performing a system upgrade using a USB drive involves writing all system files onto a USB 
drive and then rebooting the pro-xi 100 system with the USB drive inserted in the system — similar to the way 
updated configurations are installed with a USB drive.

Notice — If power is lost during the upgrade process, the pro-xi 100 system may become inoperative and need to be 
returned to the factory to be restored.
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To create a USB drive for system upgrades

1. Click File > Open.

2. Select the configuration you wish to export as part of the system upgrade to the USB drive.

3. Click Export > Create Rescue USB Drive.

The USB Rescue Options dialog opens.

4. Confirm that Copy Files to System is selected, so the latest system upgrades will be copied to the pro-xi 100 
system. 

5. Ensure that all boxes in the Burn Operations section are selected. This will ensure that all FPGA files, 
Linux® operating system files and the boot loader are all burned into non-volatile memory.

6. Click OK to accept these settings.

The Browse dialog opens.

7. Select the formatted USB drive.

8. Click OK.

All necessary files will be copied to the USB drive and the Export Configuration Fileset status dialog opens.

 This operation will take several minutes.

9. Once all files have been copied to the USB drive, a dialog displays to indicate the USB drive was created.

10. Eject the USB drive to ensure all files are written to the drive before its removal:

a. Return to the Windows® drive listing.

b. Select the USB drive in the list.

c. Click Eject or Safely Remove Drive.

Inserting the USB Drive

Before proceeding, ensure the pro-xi 100 system is powered down.

To power down the system

1. If the system is currently running, use the System Reboot / Shutdown menu, to execute a safe system 
shutdown. Refer to the section “System Reboot/Shutdown Menu” on page 50 for details.

2. After the pro-xi 100 system indicates it is safe to remove power, disconnect power to both AC inputs on the 
rear of the chassis.
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To insert the USB Drive

1. Insert the USB drive into the CTC card in the USB3 slot, which is just above the Ethernet port.

2. Apply power to the pro-xi 100 system by connecting power to both inputs on the rear of the chassis.

3. As the pro-xi 100 system boots, the boot screen is displayed.

4. At approximately the 40% point, the configuration copy and burn operation begins.

5. When the configuration copy and burn operation is complete, the boot screen will indicate this status and 
prompt the user to remove the USB drive and reboot the pro-xi 100 system.

6. Disconnect power to both AC inputs on the rear of the chassis.

7. Remove the USB drive. 

8. After the USB drive has been removed and power has been off for a minimum of 10 seconds, re-apply power to 
both AC inputs on the rear of the chassis.

The pro-xi 100 system will reboot using the updated configuration.

Audio Out
Mouse/Keyboard

Mouse/Keyboard

USB Drive

Ethernet
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System Upgrades via a Network
The pro-xi 100 system is based on Field Programmable Gate Array (FPGA) technology, which means that not only 
can new software features be added in the field, but new hardware features can as well. The data used to initialize 
the FPGA devices are stored in non-volatile memory, and these memory devices also hold the Linux® operating 
system software images that drive and operate the pro-xi 100 system.

The procedure for performing a system upgrade across the network involves creating or opening a connection to the 
target pro-xi 100 system, copying the files across the network, and starting the system upgrade process from the 
keyboard so the gateware data and Linux images are burned into the non-volatile memory. Once these memory 
devices are updated, the pro-xi 100 system is restarted to utilize the new hardware and software upgrades.

Before You Begin

Before beginning the upgrade process:

• Make sure there is reliable power available for the 45-minute (approximate) upgrade time frame. The use of an 
Uninterrupted Power Supply (UPS) is highly recommended. 

• During the upgrade procedure, the pro-xi 100 system will be unavailable for normal operations.

Creating a Network Connection

The first step in performing a system upgrade across the network is to create a network connection to the pro-xi 100 
system. If a network connection for the target pro-xi 100 system already exists, this step can be skipped and you can 
proceed to “Opening a Network Connection” on page 76.

 These steps only need to be done once for each pro-xi 100 system in use. After the network connection entry is 
created, the connection can be opened.

To create a network connection

1. Click Connection.

The Workstation Connection dialog opens.

2. Click New.

The Add Workstation dialog opens.

Notice — If power is lost during the upgrade process, the pro-xi 100 system may become inoperative and need to be 
returned to the factory to be restored.
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3. Enter the IP address assigned to the pro-xi 100 system in the IP Address field.

4. Provide a label to make identifying the pro-xi 100 system easier.

5. Click OK to accept the settings.

The new network connection entry displays.

Opening a Network Connection

 Before opening a network connection to a pro-xi 100 system, make sure it is powered on and has completed its 
boot-up operation.

To open a network connection to a pro-xi 100 system

1. Create a pro-xi 100 system network connection as outlined in the previous section.

2. Connect to the pro-xi 100 system by selecting the entry in the list for the target pro-xi 100 system.

3. Click Connect.

4. If the network connection is successfully established, a green check-mark displays.

Exporting the System Upgrades

Once the network connection is established, it is time to open a configuration and export it, and all system upgrades, 
across the network.
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To export a system upgrade across the network

1. Click File > Open.

2. Select the configuration you wish to export. 

3. Click Export > Export fileset to remote system….

The the Remote Export Options dialog opens.

When a system upgrade is provided, the instructions will specify which export options should be selected.

4. When exporting system upgrades, refer to the release notes for instructions as to which check boxes in the 
Export Options area should be selected.

5. Click OK to accept the settings and begin the export operation.

6. Use the Export Configuration Fileset dialog to monitor the export progress.

7. After the files are exported to the pro-xi 100 system, the completion dialog opens.

8. Click OK to close the dialog.

Burning the Upgrades

Now that the system upgrades have been exported to the pro-xi 100 system, the burn operation must be started from 
the keyboard of the pro-xi 100 system. Refer to “Upgrade Menu” on page 46 for information on how to start an 
upgrade operation.

 Depending on the number and types of upgrades being installed, the upgrade operation can take between 10-50 
minutes to complete. Once the upgrade is complete, the pro-xi 100 system will indicate it is completed.

All that is needed is to reboot the pro-xi 100 system so that it will utilize the new system upgrades. To execute a safe 
system shutdown, refer to “System Reboot/Shutdown Menu” on page 50.

After the pro-xi 100 system indicates it is safe to remove power, disconnect power to both AC inputs on the rear of 
the chassis and wait a minimum of 10 seconds before re-connecting power to both AC inputs.

The pro-xi 100 system will reboot using the new software and gateware updates.
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System Window Frames
The pro-xi 100 system inserts a graphical frame around the window of each external computer system displayed on 
the screen. This chapter outlines the components and configuration options of the pro-xi 100 system window 
frames.

Introduction to Frames

The frame is color-keyed, and text is inserted at the bottom of the frame (also known as Under Monitor Display or 
UMD) or the top of the frame (also known as Over Monitor Display or OMD). The text provides information about 
the connected computer system it surrounds. A portion of a frame is in Figure 18.1, with the text at the UMD 
position.

Figure 18.1  Example of an UMD Frame

In Figure 18.1, the external computer system has been labeled Lab Win7 DualHead, and the window being 
displayed is the Main system window - as opposed to the sub-window for this same system. The external computer 
system's video output is sending 1920 pixels by 1200 scans, is displaying 60 frames-per-second (60Hz), and is 
supplying the pro-xi 100 system with a DVI signal.

Frames are color-keyed to assist the Operator in determining which external computer system is active or selected, 
as well as which sub-window is associated with which main window. As the Operator selects and activates external 
computer systems, the frame colors will change to show the new status. The Operator has full control over the 
frame and text colors, and can easily change them.

Frames Configuration Dialog

The Frames Configuration dialog contains sections where the frame state and text position can be selected, the 
frame labels can be modified, and the frame and text colors can be updated.

 Prior to opening the Frames Configuration dialog, make sure a network connection has been established with the 
pro-xi 100 system.

To change frame selections on the pro-xi 100 system

1. Click File > Open.

2. Select the configuration to be changed from the list.

The selected configuration opens.

3. Click Settings > Frames Configuration.

The Frames Configuration dialog opens.
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Enabling Frames and Changing the Text Position

You can view the frame changes being made on the pro-xi 100 system in real-time.

To enable frames

1. To enable frames select from the following:

• Frames Enabled, Text at UMD Position — Select this option to have the frame text be displayed 
underneath the external computer system screen.

• Frames Enabled, Text at OMD Position — Select this option to enable frames and have the frame text be 
displayed at the top of the screen. 

• Frames Disabled — Select this option to disable frames.

 If a network connection is established, clicking Send Update after any changes will display them on the pro-xi 
100 system. Send Update only makes temporary changes to the pro-xi 100 system, which will be lost if the 
system is rebooted. To make the changes permanent, the configuration must be saved and exported to the pro-xi 
100 system.

2. Click OK to accept the changes, or Cancel to exit.

 If Cancel is selected, any changes made to frame state, labels or colors will be removed, and the original state, 
labels and colors will be restored. This allows the Operator to experiment with all the frame options and easily 
revert back to the original settings if needed.

3. Once the frame selections have been made, the configuration should be saved and then exported to the pro-xi 
100 system. Refer to “Exporting a Configuration via USB” on page 63 or “Exporting a Configuration 
Across the Network” on page 67 for more information.

Changing Frame Labels

To change the frame labels

1. Click one of the labels in the Frame Labels list to open the Change Frame Info dialog.

2. Enter the new label for the specified external computer system.

3. Click OK.

The updated label will be displayed in the list.

4. Click Send Update to display the new label on the pro-xi 100 system.
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Changing Frame Colors

To change a specific frame color

1. Click the color swatch for the color item to be changed to open the Color Selection dialog.

2. Select the new color for the color item to be changed.

3. Click OK.

The updated color will display in the Color Swatch field.

4. Click Send Update to display the new color item on the pro-xi 100 system.

Differences in Sub-window Frames

In a Sub-window frame, the label and video source are displayed the same as the Main window. But instead of 
showing the pixel and scan size of the external computer system's video output, the Sub-window will display its 
own current width and height, along with text identifying it as a Sub-window. (Figure 18.2)

Figure 18.2  Example of a Sub-window UMD Frame

Changing the Frame Text Position

The frame's text is normally positioned underneath the external computer system's screen. This is known as the 
Under-Monitor-Display (UMD) location. Some Operators prefer the text to be displayed above the external 
computer system's screen at the Over-Monitor-Display (OMD) location.

Use the following key sequence to toggle between disabled frames, text at the UMD position and text at the OMD 
position:

 The Start key is the left GUI key on your keyboard.

+ U
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Windows Select Mode

When the Operator chooses to disable frames, they may still want a visual mechanism to see which connected 
system has been selected or is active. This operational mode is called Windows Select, and is enabled from the 
keyboard by holding down SHIFT + CTRL and pressing F6.

In Figure 18.3, both images have their frames disabled, the image on the left has windows select mode disabled, 
and the one on the right has windows select mode enabled.

  
Figure 18.3  Example of a Window Select Mode

As the example shows, all of the connected system windows appear dim when windows select mode is enabled and 
the window is not selected or active. When a window is selected or is made active, the window will immediately 
switch to full brightness, as shown in Figure 18.4.

Figure 18.4  Example of a Selected Window

When the windows select mode is enabled, if a sub-window is associated with a selected or active window, it will 
also be displayed at full brightness. In Figure 18.5, all eight main windows have an associated sub-window, but 
only the selected window and its sub-window are displayed at full brightness.

Figure 18.5  Example of a Selected Window and its Sub-window
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The dimness or brightness of all non-selected windows can be adjusted from the keyboard.

To decrease the brightness of non-selected windows

• Hold down the SHIFT + CTRL and press F7. 

To increase the brightness

• Hold down SHIFT + CTRL and press F8.
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Bezel Color Notifications
The illuminated front bezel on the pro-xi 100 system is used to provide color-based notifications to operators, 
system administrators and other engineering and IT personnel who work in the physical area the pro-xi 100 system 
has been installed, but who may not have immediate access to the system to view the notifications.

Colors are displayed for each of the four primary system notification groups:

• Normal operations

• Informational notifications

• Warning and urgent notifications

• Critical and failure notifications

Each of the notification groups are associated with a specific bezel color. During normal operations (and with no 
notifications pending), the bezel color will be set to the color of normal operations. If notifications of any type are 
generated by the pro-xi 100 system, the bezel color will change to indicate the type of notification, and will remain 
that color until the notification has been cleared, or a higher-priority notification is received.

A priority scheme has been implemented so that more severe system notifications over-ride lower-level 
notifications. This means that if an informational notification had been posted earlier and the bezel color was 
changed, and a warning notification occurred later, the bezel color would change to indicate the warning.

The bezel colors associated with the four notification groups can be changed by the Operator.

Bezel Configuration Dialog

The Bezel Configuration dialog contains sections where colors for each of the four notification groups can be 
changed, along with a brief description of the notification group.

 Prior to opening the Bezel Configuration dialog, make sure a network connection has been established with the 
pro-xi 100 system.

To change bezel notification colors on the pro-xi 100 system

1. Click File > Open.

2. Select the configuration to be changed from the list.

The selected configuration opens.

3. Click Settings > Bezel Configuration to display the Bezel Configuration dialog.
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Changing Bezel Notification Colors

You can view the bezel changes being made on the pro-xi 100 system in real-time.

To change a specific bezel notification color

1. Select the color swatch for the item to be changed.

The Color Selection dialog opens.

2. Select the new color for the item to be changed.

3. Click OK. 

The updated color will appear in the color swatch.

4. If a network connection is established, clicking Send Update after any changes will display them on the pro-xi 
100 system.

Send Update only makes temporary changes to the pro-xi 100 system, which will be lost if the system is 
rebooted. To make the changes permanent, the configuration must be saved and exported to the pro-xi 100 
system.

5. Click OK to accept the changes, or Cancel to exit.

If Cancel is selected, any changes made to the bezel notification color will be removed, and the original colors 
will be restored. This allows the Operator to experiment with the bezel color options and easily revert back to 
the original settings if needed.

6. Once the bezel notification color selections have been made, the configuration should be saved and then 
exported to the pro-xi 100 system. Refer to “Exporting a Configuration via USB” on page 63 or“Exporting 
a Configuration Across the Network” on page 67 for more information.
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Real Time Clock Display
The pro-xi 100 system can be configured to display a real-time clock (RTC) as part of the background canvas. This 
chapter outlines the RTC display and configuration options.

Overview

The clock can be configured for 12-hour or 24-hour time formats, can be positioned at any of nine different 
locations on the screen, and can be set to one of three different sizes. In Figure 20.1, the RTC has been set to the 
largest size, positioned in the middle of the screen, and has been set to the 12-hour time format.

Figure 20.1  Example of a Display with RTC

If the pro-xi 100 system has been connected to a network, the RTC can be externally synchronized to a Network 
Time Protocol (NTP) time reference found on the Internet, or to an internal facility reference.

Real Time Clock Configuration Dialog

The Clock Settings dialog contains the following sections:

• The VOC1 and VOC2 Settings sections for configuring the clock display options.

• The NTP Server Settings section for synchronizing with an external time reference.

• The Timezone section for specifying the local time zone.

To display the real time clock settings on the pro-xi 100 system

1. Click File > Open.

2. Select the configuration to be changed from the list.

The configuration opens.

3. Click Settings > Clock Settings.

The Clock Settings dialog opens.
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Modifying the Clock Settings

The RTC can be displayed on one or both VOC outputs of the pro-xi 100 system.

To enable the RTC display

1. Ensure the Enable Clock on Display box is selected.

2. Specify the time format and clock size.

3. Select a clock position. Choose from the following:

• top-left

• top-center

• top-right

• middle-left

• middle-center

• middle-right

• bottom-left

• bottom-center

• bottom-right

Enabling Internet-Based NTP Time Synchronization

The NTP protocol provides only a 1-second resolution clock reference. Because of this, it is possible for the pro-xi 
100 system to be up to one second early or late in time when compared to other systems synchronized to the same 
NTP server.

To synchronize the pro-xi 100 system with an external NTP time reference on the Internet, make sure the Enable 
Time Synchronization box is selected.

To use the default NTP servers on the Internet, clear the NTP Server box. When this is the case, the pro-xi 100 
system will synchronize itself with the huge NTP server pool at ntp.org. There is a set of four virtual NTP servers 
found at these locations:

• 0.pool.ntp.org

• 1.pool.ntp.org

• 2.pool.ntp.org

• 3.pool.ntp.org
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When referenced, each of these four virtual NTP servers will randomly select one of several hundred NTP servers 
on the Internet that participate in the ntp.org pool. This ensures that all servers in the pool share the connection load.

How often the pro-xi 100 system synchronizes itself with the servers at ntp.org is specified by setting the value in 
the NTP Period box. This value is the number of seconds between synchronization operations.

 To prevent the pro-xi 100 system from being blocked by the servers at ntp.org, do not set the NTP period any 
lower than 180 seconds.

Enabling Facility-Based NTP Time Synchronization

To synchronize the pro-xi 100 system with an internal facility time reference

1. Ensure the Enable Time Synchronization box is selected.

2. Set the NTP Server menu to the IP address of the internal facility time reference.

3. Set the NTP Period menu to the synchronization rate suggested by the internal time reference device.

 If no value is suggested, a period of 300 seconds (5 minutes) can be used as a default.

Configuring the Local Timezone

The pro-xi 100 system supports timezone settings for all standard US timezones:

• Hawaii-Aleutian Standard Time

• Alaska Standard Time

• Pacific Time

• Mountain Time

• Mountain Time (No DST)

• Central Time

• Central Time (No DST)

• Eastern Time

The pro-xi 100 settings can also support a user-supplied timezone value.

To set the timezone

• Select it from the timezone list, or 

• Select User-Supplied to enter a custom designation.
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Desktop Settings
Operators of the pro-xi 100 system utilize a Status Bar to gain access to the various menus and dialogs used to 
control the system. The Desktop Settings dialog allows the Operator to configure the location and animation used to 
display the Status Bar, as well as the Bug option which can provide a visual hint to the Operator that the display 
they are looking at is coming from a connected pro-xi 100 system that is full-screen.

Desktop Settings Dialog

The Desktop Settings dialog contains two sections: Status Bar Options and Bug Options.

To change the desktop settings on the pro-xi 100 system

1. Click File > Open.

2. Select the configuration to be changed from the list.

The configuration opens.

3. Click Settings > Desktop Settings.

The Desktop Settings dialog opens.

Status Bar Options

The Status Bar will always appear at the bottom of the display, and it can be configured to be flush with the bottom 
of the display or indented. The Position section is used to specify the location of the Status Bar.

The Animation section is used to specify what type of animation (if any) is used to display the Status Bar. In the 
example above, the Fast Dissolve animation is selected to fade in and out the Status Bar at a fast speed. Other 
animations can be selected to pop the Status Bar in and out without any animation, perform a slow dissolve, or fast 
or slow sliding of the Status Bar.

Bug Options

The bug is a small icon that can be displayed in any of the four corners of the active system, and can be set 
completely opaque, entirely transparent, or anywhere in between. The bug icon is shown in Figure 21.1.

Figure 21.1  Example of a Bug Icon
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The bug is used to watermark an active connected computer system so that if the Operator were to approach the 
display, they could determine visually if the display was a pro-xi 100 output of a connected system being shows 
full-screen, or another computer system.

To enable the bug on active connected systems

1. Select one of the four positions from the Position menu.

2. Select the transparency value.

When a connected system is made active and taken full-screen, the bug will appear in one of the corners of the 
active system, as shown in Figure 21.2.

Figure 21.2  Example of a Bug Icon on an Active Screen

In Figure 21.2, the bug is set to appear in the upper-right corner and has a transparency value of 50%. If a 
connected system is taken full-size but its aspect ratio is such that it won't fill the screen, the bug will still appear in 
the selected corner, as shown in Figure 21.3.

Figure 21.3  Example of a Bug Icon in a Selected Corner

In Figure 21.3, the bug can be seen in the upper-right corner of the active system, and the top of the video window 
can be seen through it. A magnified view is shown in Figure 21.4.

Figure 21.4  Example of a Bug Icon with a Search Box

 If a network connection is established, clicking Update after any changes will transfer them to the pro-xi 100 
system. Update only makes temporary changes to the pro-xi 100 system, which will be lost if the system is 
rebooted. To make the changes permanent, the configuration must be saved and exported to the system.



pro-xi 100 User Guide (v4.0) Dual Operator Configuration • 93

Dual Operator Configuration
When configuring the pro-xi 100 system for Dual Operators, four operations are performed, all done while the 
pro-xi 100 system is still running in its original single-operator configuration:

• Physically setting up the keyboard, mouse and monitor at the two Operator positions

• Identifying the USB ports used for both keyboards and both mice

• Determining which connected systems will be shared by both Operators, and which connected systems will be 
owned by one or the other Operator

• Sending the new configuration to the pro-xi 100 system

Each of these steps are described in this chapter.

Setting Up the Second Operator Position

When operating the pro-xi 100 system in a Dual Operator configuration, the video output from VOC1 is used as the 
video output for the Operator1 position, the video output from VOC2 is used as the video output for the Operator2 
position, and a USB hub is used to connect both keyboard and mouse pairs to the pro-xi 100 system.

The USB hub must support the USB 2.0 protocol, and support at least four ports, but larger hubs may also be used. 
In addition, smaller hubs, such as a four-port hub, can draw their power from the pro-xi 100 system and will not 
require an external power source. Usually, when hubs support more than four ports, they will require an external 
power source. 

Figure 22.1 is the connection diagram for the Dual Operator configuration.

Figure 22.1  Connections — Dual Operator Setup
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Identifying the USB Port Numbers

When connecting the two keyboard/mouse pairs, it's not critical which of the USB ports they are plugged into. 
What is important is to note which USB port number is displayed on the pro-xi 100 system monitor when the USB 
keyboard or mouse is attached. When a USB keyboard or mouse device is removed or attached to the pro-xi 100 
system, a pop-up dialog display that contains the USB port information (Figure 22.2).

Figure 22.2  System Notification Dialog

In Figure 22.2, the pop-up dialog reports the name the USB device (USB Optical Mouse), along with the device 
type (mouse) and the port number (1.7.2). As the keyboard and mouse devices for each of the Operator positions is 
attached, make note of the USB port number for later use when setting up a configuration for Dual Operator.

Shared Versus Owned Connected Systems

Each connected system must be chosen to be either “shared” by both Operators or “owned” by one of the two 
Operators. The differences between shared and owned systems are described below.

An owned connected system can:

• be moved from one desktop to the other, or can span both desktops so either Operator can access it

• have sub-windows

• be recalled with a layout key and “recalled” from the other Operator

• be “cloned” and the cloned copy shared with the other Operator

A shared connected system:

• appears on both desktops at the same time

• cannot be moved to the other Operator's desktop

• does not have sub-windows

• can never be “recalled” by the other Operator

To better illustrate the differences, consider the following images, which show a Dual Operator configuration where 
three connected systems are owned by Operator1, three connected systems are owned by Operator2 (two ISC cards 
are configured as a dual-head system in this example), and the last two connected systems are shared between them:

Figure 22.3  Example of Dual Operator Configuration

Systems Shared by Both Operators

Systems Owned by Operator 1 Systems Owned by Operator 2
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Configuring the Dual Operator Options

To create a Dual Operator configuration, it's easiest to start with an existing single-operator configuration.

To create a dual-operator configuration

1. Launch the proxi-app utility.

2. Select File > Open.

3. Select the configuration to be used as the reference.

4. Save this configuration using a new name:

a. Select File > Save As.

b. Enter the new configuration's name.

c. Follow the on-screen instructions.

5. Select Settings > Multiple Operators to display the Multiple Operator Options dialog.

When running as a single-operator system, the All Operators Share pro-xi Control radio button will be 
selected, and the USB Port Assignments and Dual Operator Options sections are uninitialized.

6. To switch over to Dual Operator, click Dual Operator Stations.

The USB Port Assignments section will change to display only Operator 1 and Operator 2, and the Dual 
Operator Options section will become active:

7. To set the USB port assignments, double-click the first Operator 1 entry in the list.

The USB Port Selection dialog opens.
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8. Enter the keyboard and mouse USB ports for Operator1 that were displayed when the keyboard and mouse 
devices for Operator1 were inserted into the USB hub. 

9. Click OK.

The new port assignments display.

10. Double-click the first Operator 2 entry in the list and do the same for the second Operator.

11. Click OK to save the second set of port assignments.

12. Set the ownership of each of the ISC cards by double-clicking on each entry in the Layout Ownership 
Assignments area.

As each ISC entry is clicked, the Layout Ownership dialog is displayed.

13. Click the associated radio button to set the ownership of the connected system to Operator 1, Operator 2, or 
shared by both Operators.
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Once all the assignments have been made, the ownership list is displayed.

  A Dual Operator system may be configured with all connected systems shared between both Operators, but it 
cannot be configured for all connected systems to be owned by one Operator.

14. Click OK to close the Multiple Operators Options dialog. 

15. Save the new configuration.

16. Export the new configuration to the pro-xi 100 system.
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Dual Operator Operations
When operating the pro-xi 100 system in a Dual Operator configuration, there are a number of features and 
enhancements available:

• Connected systems that are shared will be displayed on both Operator desktops, and cannot be moved off the 
display.

• Connected systems that are owned can be moved from one Operator desktop to the other, and can also be 
positioned so that the system spans both displays — allowing either operator to take control.

• Owned systems can be recalled back from the other Operator — even if they happen to be in control of that 
system.

• When a system is actively controlled by one Operator, that system will be locked out from access by the other 
Operator.

• Each Operator can independently position and scale their windows, and they have their own set of layouts.

• Each Operator has their own Status Bar with access to all the system dialogs.

• If a connected system is owned, it can be cloned and the cloned window can be pushed over to the other Operator 
desktop.

Controlling a Dual Operator System

In the following examples and explanations, the pro-xi 100 system has been configured with three connected 
systems owned by Operator 1, three connected systems owned by Operator 2, and two connected systems shared 
between them, as shown in Figure 23.1.

Figure 23.1  Example of Dual Operator System Configuration

Each Operator has full control over the placement and size of connected system windows on their desktop. In 
Figure 23.2, we see that Operator 1 has selected one of the shared systems by the color change in the frame; we can 
also see the frame has changed color on Operator 2’s desktop.

Systems Shared by Both Operators

Systems Owned by Operator 1 Systems Owned by Operator 2
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When a connected system is made active and is under control by one of the Operators, it will be locked out from the 
other Operator and an overlay is applied to inform the second Operator that this system is unavailable. In Figure 
23.3, we see that Operator 1 has taken control of one of the shared systems and has locked out Operator 2.

When a connected system is owned, it can be positioned so that it spans both desktops, allowing either Operator to 
access it. In Figure 23.4, we see that Operator 2 has positioned a dual-head connected system so it appears on both 
desktops, and that Operator 2 has selected the dual-head system (due to the change in color of its frame):

When a system spans both displays and is under control by one Operator, the other Operator will still see that the 
system is locked out and unavailable. In Figure 23.5, we see Operator 1 has taken control of the dual-head system 
and has locked out Operator 2.

Figure 23.2  Example of Two Operator Desktops

Figure 23.3  Example of a Shared System where Operator2 is Locked Out

Figure 23.4  Example of a Shared System with Dual Heads
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Each Operator has access to their own Status Bar and system dialogs. In Figure 23.6, Operator 1 opened the Health 
Status dialog while Operator 2 is actively controlling the dual-head system.

Figure 23.5  Example of a Dual-Head System with Operator2 Locked Out

Figure 23.6  Example of Status Bar and System Dialogs in a Dual-Head System
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Keyboard Shortcuts
This chapter lists the keyboard shortcuts for carousel control, system activation, and other common functions.

Carousel Control

System Activation

 Use the number keys located in the keypad area of your keyboard.

Function Keyboard Shortcut

Rotate through and take control of 
each system (work area)

Rotate through and take control of 
each system (scaled)

Decrease carousel scale size

Increase carousel scale size

Function Keyboard Shortcut

Activate connected system

Deactivate the active system

Deactivate the active system

Shift + +Ctrl
Space

Shift + Ctrl + + Space
Alt

Shift + Ctrl + +Alt

+Shift + Ctrl + Alt

+ ...1
End

8Shift + Ctrl + Alt

+ 0
Ins

Shift + Ctrl + Alt

+Shift + Ctrl + Alt
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Window Select Mode

Window Control

 The Start key is the left Windows key on your keyboard.

Cursor Speed and Sensitivity

Function Keyboard Shortcut

Disable window select mode

Enable window select mode

Decrease unselected window brightness

Increase unselected window brightness

Function Keyboard Shortcut

Clone the selected window

Hide the selected window

Reveal all hidden windows

Function Keyboard Shortcut

Decrease cursor speed

Increase cursor speed

Shift + +Ctrl F5

Shift + +Ctrl F6

Shift + +Ctrl F7

Shift + +Ctrl F8

+ C

+ H

+ R

+Shift + Ctrl

+Shift + Ctrl
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System Commands

 The Start key is the left Windows key on your keyboard.

Function Keyboard Shortcut

Re-synchronize selected system's video 
source

Display on-screen help pages

Toggle the active bug position

Display system video test patterns

Display / hide system information screen

Toggle frame text position and state

Display / hide system Status Bar

Shift + +Ctrl F12

+ ?
/

+ B

+ P

+ S

+ U
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Video Test Patterns
The pro-xi 100 system can generate internal video test patterns that are displayed on both video outputs. The video 
test patterns are generated digitally, and are of the highest resolution and quality.

These video test patterns are used as a technical reference to evaluate computer monitors, television displays and 
video walls attached to the pro-xi 100 system, as well as the video signal processing components that are inserted 
between the pro-xi 100 systems output cards and the final display output device. These processing components 
include KVM extenders, KVM matrix systems, frame synchronizers, video compression/decompression systems, 
standards converters, video routers, etc.

 To display the video test patterns, hold down the Start key and press P to toggle through the test pattern set.

Circular Elements

The circular elements in the test patterns show distortions in the image if it is stretched as it is being displayed. For 
example, many computer monitors with a 16:10 aspect ratio will stretch a 16:9 aspect ratio image to fill the display. 
If this happens, the circular elements will appear oblong.

Ramp Elements

The gray, red, green and blue ramps in the test patters show distortions in color processing, color space conversion 
and compression artifacts. The ramps should be a single, continuous, smooth ramp from one end to the other.

Horizontal Resolution Elements

The square horizontal resolution elements in the test patterns are used to determine the highest video resolution 
available for the video output pipeline. The left-most squares interleave single white and black lines together. If the 
video output pipeline is unable to support this resolution, the viewer will be unable to resolve the individual black 
and white lines and the block will appear smeared.

As the viewer looks at the blocks from left-to-right, the thickness of the black and white lines are increased (2 black, 
2 white; 3 black, 3 white; etc.), and the viewer should eventually locate a block where the white and black lines can 
be seen with no distortions. This block represents the highest Lines of Horizontal Resolution (LHR) value the video 
output pipeline is able to sustain.

If the highest LHR block that can be viewed properly is not the left-most, then the video output pipeline and/or 
display devices are unable to display the pro-xi 100 system at its highest possible video quality level.
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Test Pattern Examples

Figure 25.1  Test Pattern 1

Figure 25.2  Test Pattern 2

Figure 25.3  Test Pattern 3
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Technical Specifications
This chapter provides technical information for the pro-xi 100 system.

 Specifications are subject to change without notice.

Supported Video Resolutions

 The pro-xi 100 system supports more than 140 progressive-scan input resolutions, but does not support any 
interlaced-scan resolutions.

Table 26.1  Supported Video Resolutions

Video Resolution Aspect Ratio Refresh Rates
DVI 

Input
VGA 
Input

DVI 
Output

2560 x 1600 16:10 60Hz •

2560 x 1440 16:9 60Hz •

2048 x 1536 4:3 60Hz 75Hz 85Hz • • •

2048 x 1280 16:10 60Hz • • •

2048 x 1152 16:9 60Hz • • •

1920 x 2400 4:5 25Hz 30Hz • • •

1920 x 1200 16:10 60Hz 72Hz 75Hz • • •

1920 x 1080 16:9 24Hz 25Hz 29Hz 30Hz 50Hz 60Hz 75Hz • • •

1856 x 1392 4:3 60Hz 75Hz • • •

1800 x 1440 5:4 60Hz • • •

1792 x 1344 4:3 60Hz 75Hz • • •

1680 x 1050 16:10 60Hz • • •

1600 x 1200 4:3 60Hz 65Hz 70Hz 75Hz 85Hz 100Hz • • •

1600 x 1024 25:16 60Hz 75Hz 85Hz • • •

1600 x 1000 16:10 60Hz 75Hz 85Hz 100Hz • • •

1600 x 900 16:9 60Hz • • •

1440 x 1050 60Hz • • •

1440 x 900 16:10 60Hz • • •

1400 x 1050 4:3 60Hz 70Hz 72Hz 75Hz 85Hz 100Hz • • •

1368 x 768 16:9 60Hz • • •

1360 x 768 16:9 60Hz • • •

1280 x 1024 5:4 60Hz 75Hz 85Hz 100Hz 120Hz • • •

1280 x 960 4:3 60Hz 75Hz 85Hz 100Hz • • •

1280 x 800 16:10 60Hz 75Hz • • •

1280 x 768 5:3 60Hz • • •

1280 x 720 16:9 50Hz 60Hz • • •

1152 x 864 4:3 60Hz 70Hz 75Hz 85Hz 100Hz • • •

1152 x 768 55Hz • • •

1024 x 768 4:3 60Hz 70Hz 75Hz 85Hz 100Hz 120Hz • • •
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Incoming System Card (ISC)

Video Output Card (VOC)

Video Resolution Aspect Ratio Refresh Rates
DVI 

Input
VGA 
Input

DVI 
Output

1024 x 600 60Hz • • •

720 x 576 5:4 50Hz • • •

720 x 480 60Hz • • •

720 x 400 85Hz • • •

640 x 480 4:3 60Hz 72Hz 75Hz 85Hz 100Hz •

640 x 400 16:10 85Hz •

640 x 350 85Hz •

Table 26.2  Technical Specifications — ISC

Item Specifications

Input Video DVI Single-Link, DVI Dual-Link, HDMIa, VGAb

a. Requires an HDMI-to-DVI adapter.
b. Requires a VGA-to-DVI adapter.

Max. Input Resolution 2048 x 1536

HDCP, interlaced video formats Not supported

Power Consumption 24 VA Max

Max. Number of Cards/Frame 8

Redundancy Hot-swappable

AUDIO IN Connector 3.5mm stereo (TRS) female

USB Connector Two USB Type ‘B’ female

VIDEO IN Connector DVI-I Single/Dual Link female (HDMI and VGA with 
adapter)

Table 26.3  Technical Specifications — VOC

Item Specifications

Output Video DVI-D Single-Link, DVI-D Dual-Link

Max. Output Resolution 2560 x 1600

Power Consumption 21 VA Max

Max. # of Cards/Frame 2

Redundancy Hot-swappable

Video Output Connector DVI-D Single / Dual-Link female

Table 26.1  Supported Video Resolutions
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Controller Card (CTC)

Cabling

Power

Environmental

Mechanical

Table 26.4  Technical Specifications — CTC

Item Specifications

Network Ethernet, 10-100 Mbps

Power Consumption 24 VA Max

Redundancy n/a

Audio Out Connector 3.5mm (TRS) female

Ethernet Connector RJ-45 CAT5 female

USB Connector Three USB Type ‘A’ female

Table 26.5  Technical Specifications — Cabling (Recommended Maximums)

Item Specifications

DVI Cables 16.4’ (5m) 24AWG for all video resolutions above 
1280x1024

VGA Cables 16.4’ (5m) 24AWG

USB Cables 16.4’ (5m)

Table 26.6  Technical Specifications — Power

Item Specifications

Input Voltage 100-240 VAC

Redundancy Dual redundant power supplies, dual redundant power 
paths

Line Frequency 50Hz - 60Hz

Power Consumption 300 VA Max

Table 26.7  Technical Specifications — Environment 

Item Specifications

Operating Temperature 10°C - 40°C

Humidity 0-90% (non-condensing)

Table 26.8  Technical Specifications — Mechanical 

Item Specifications

Height 5.25” (13.34 cm)   3RU

Width 17” (43.18 cm) chassis   19” rack mount standard

Depth 19.5” (49.53 cm)   bezel – latch

Weight 42 lb.
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Software Licenses
This chapter provides third-party software license information for your pro-xi 100 Workstation Integrator. This 
product includes multiple software components which are individually licensed under one or more of the following 
licenses included in this chapter.

GPL
GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. http://fsf.org/

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Pub-
lic License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free 
Soft- ware Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply 
it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distrib-
ute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces 
of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if 
you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must 
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission 
to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL 
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is funda-
mentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for indi-
viduals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If 
such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose 
computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the 
GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0.Definitions.

 "This License" refers to version 3 of the GNU General Public License.

"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or 
organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The 
resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copy- 
right law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available 
to the public, and in some countries other activities as well.

To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, 
with no transfer of a copy, is not conveying.

An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an 
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey 
the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in 
the list meets this criterion.
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1.Source Code.

The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a partic-
ular programming language, one that is widely used among developers working in that language.

The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Compo-
nent, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface 
for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, win-
dow system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code inter-
preter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code 
and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally 
avail- able free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes 
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is spe-
cifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source. The Corresponding 
Source for a work in source code form is that same work.

2.Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License 
explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, 
given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey 
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided 
that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for 
you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material out-
side their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3.Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright 
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by 
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of 
enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

4.Conveying Verbatim Copies.

You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each 
copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; 
keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5.Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided 
that you also meet all of these conditions:

a)The work must carry prominent notices stating that you modified it, and giving a relevant date.

b)The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies the 
requirement in section 4 to "keep intact all notices".

c)You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along with any 
applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no permission to license the 
work in any other way, but it does not invalidate such permission if you have separately received it.

d)If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not display 
Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not com-
bined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting 
copy- right are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an 
aggregate does not cause this License to apply to the other parts of the aggregate.

6.Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source 
under the terms of this License, in one of these ways:

a)Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source fixed on a 
durable physical medium customarily used for software interchange.

b)Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at least three 
years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code either (1) a copy of the 
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Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily used for software inter- change, 
for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding Source from a network 
server at no charge.

c)Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only occasionally and 
noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d)Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in the same way 
through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. If the place to copy the 
object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, 
provided you maintain clear directions next to the object code saying where to find the Corresponding Source. Regardless of what server hosts the Corresponding 
Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

e)Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work are being 
offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the 
object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, 
or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor 
of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status 
of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless 
of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified ver-
sions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued func-
tioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which 
the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), 
the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor 
any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has 
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modifica-
tion itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an 
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7.Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that 
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional 
per- missions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License 
without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permis-
sions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a 
covered work, for which you have or can give appropriate copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supple-
ment the terms of this License with terms:

a)Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b)Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works contain-
ing it; or

c)Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different from the 
original version; or

d)Limiting the use for publicity purposes of names of licensors or authors of the material; or

e)Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f)Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual assumptions of 
liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, 
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a 
further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, 
or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either 
way.

8.Termination.

 You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will 
automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).
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However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright 
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior 
to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, 
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after 
your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights 
have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9.Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a conse-
quence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to 
propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, 
you indicate your acceptance of this License to do so.

10.Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to 
this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organiza-
tions. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever 
licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the 
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, roy-
alty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging 
that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11.Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called 
the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be 
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a 
consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, 
import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express per- 
mission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commit-
ment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge 
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding 
Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent 
license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that 
country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent 
license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent 
license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or 
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is 
in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered 
work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered 
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under 
applicable patent law.

12.No Surrender of Others' Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the con-
ditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, 
then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom 
you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13.Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU 
Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the 
covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combi- 
nation as such.
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14.Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later ver-
sion" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.

 If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance 
of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result 
of your choosing to follow a later version.

15.Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TIC- ULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16.Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY 
WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT 
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE 
OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSI- BILITY OF SUCH DAMAGES.

17.Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local 
law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies 
a copy of the Program in return for a fee.

jQuery

jQuery utilizes the MIT license - see below.
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LGPL
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the 
additional permissions listed below.

0.Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public 
License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class 
defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined 
Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the 
Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs 
needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1.Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

 2.Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than 
as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a)under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility still oper-
ates, and performs whatever part of its purpose remains meaningful, or

b)under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3.Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your 
choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and 
templates (ten or fewer lines in length), you do both of the following:

a)Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b)Accompany the object code with a copy of the GNU GPL and this license document.

4.Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in 
the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a)Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b)Accompany the Combined Work with a copy of the GNU GPL and this license document.

c)For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a reference 
directing the user to the copies of the GNU GPL and this license document.

d)Do one of the following:

1)Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under terms that 
permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, in the manner specified 
by section 6 of the GNU GPL for conveying Corresponding Source.

2)Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library already present on 
the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the Linked Version.

e)Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to the extent 
that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the Application with a mod-
ified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal Corresponding Source and Corresponding 
Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified by section 6 of the GNU GPL for conveying Corre-
sponding Source.)

5.Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and 
are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
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a)Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the terms of this 
License.

b)Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying uncombined form of 
the same work.

6.Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public 
License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published 
by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any 
version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public 
statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT

Copyright 1987, 1988 by MIT Student Information Processing Board.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the 
M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. 
S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Unlicense

This is free and unencumbered software released into the public domain.

Anyone is free to copy, modify, publish, use, compile, sell, or distribute this software, either in source code form or as a compiled binary, for any purpose, commercial 
or non-commercial, and by any means.

In jurisdictions that recognize copyright laws, the author or authors of this software dedicate any and all copyright interest in the software to the public domain. We 
make this dedication for the benefit of the public at large and to the detriment of our heirs and successors. We intend this dedication to be an overt act of relinquish-
ment in perpetuity of all present and future rights to this software under copyright law.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE AUTHORS 
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

For more information, please refer to <http://unlicense.org/>

zlib

Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft- 
ware.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

 1.The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowl-
edgment in the product documentation would be appreciated but is not required.

2.Altered source versions must be plainly marked as such and must not be misrepresented as being the original software.

3.This notice may not be removed or altered from any source distribution. Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), 
rfc1951.txt (deflate format) and rfc1952.txt (gzip format).



120 • Software Licenses pro-xi 100 User Guide (v4.0)



pro-xi 100 User Guide (v4.0) Creative Commons 3.0 License • 121

Creative Commons 3.0 License
The movie images displayed in many of the screen-shots in this manual are licensed under the Creative Commons 
“Attribution” license, which can be found at creativecommons.org/licenses/by/3.0/. This license provides for the 
sharing of these videos in any medium or format as long as appropriate credit is provided to the content creators, a 
link to the license is provided, and an indication if changes to the content were made.

Big Buck Bunny

The story of a large bunny defending his woodland friends against a trio of evil forest animals.

Website:peach.blender.org

License:Creative Commons Attribution 3.0

Changes:None

Attribution:© copyright 2008, Blender Foundation / www.bigbuckbunny.org

Tears of Steel

The story of a romance gone bad between a boy and a girl - who later transforms herself into a cyborg, builds a robot army, and attempts to destroy the world.

Website:mango.blender.org

License:Creative Commons Attribution 3.0

Changes:None

Attribution:(CC) Blender Foundation | mango.blender.org

Sintel

The story of a girl's search for her pet baby dragon - stolen from her by another dragon.

Website:durian.blender.org

License:Creative Commons Attribution 3.0

Changes:None

Attribution:© copyright Blender Foundation | durian.blender.org

© copyright Blender Foundation | www.sintel.org
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Service Information
This chapter provides information on the warranty and repair policy for your pro-xi 100 system.

Troubleshooting Checklist

Routine maintenance to this Ross product is not required. In the event of problems with your pro-xi 100, the 
following basic troubleshooting checklist may help identify the source of the problem. If the pro-xi 100 still does 
not appear to be working properly after checking all possible causes, please contact your Ross products distributor, 
or the Technical Support department at the numbers listed under the “Contacting Technical Support” on page 12.

1. Visual Review — Performing a quick visual check may reveal many problems, such as connectors not properly 
seated or loose cables. Check the pro-xi 100 unit and any associated peripheral equipment for signs of trouble.

2. Power Check — Verify the power cable is connected to a power source and that power is available at the power 
main. 

3. Input Signal Status — Verify that source equipment is operating correctly and that a valid signal is supplied.

4. Output Signal Path — Verify that destination equipment is operating correctly and receiving a valid signal.

5. Module Exchange — Exchanging a suspect module with a module that is known to be working correctly is an 
efficient method for localizing problems to individual modules. 

Warranty and Repair Policy

The pro-xi 100 is warranted to be free of any defect with respect to performance, quality, reliability, and 
workmanship for a period of ONE (1) year from the date of delivery to the customer. In the event that your pro-xi 
100 proves to be defective in any way during this warranty period, Ross Video Limited reserves the right to repair 
or replace this piece of equipment with a unit of equal or superior performance characteristics.

Should you find that this pro-xi 100 has failed after your warranty period has expired, we will repair your defective 
product should suitable replacement components be available. You, the owner, will bear any labor and/or part costs 
incurred in the repair or refurbishment of said equipment beyond the ONE (1) year warranty period.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profits) incurred by the use of this product. Implied warranties are expressly limited to the 
duration of this warranty.

This pro-xi 100 User Guide provides all pertinent information for the safe installation and operation of your pro-xi 
100. Ross Video policy dictates that all repairs to the pro-xi 100 are to be conducted only by an authorized Ross 
Video Limited factory representative. Therefore, any unauthorized attempt to repair this product, by anyone other 
than an authorized Ross Video Limited factory representative, will automatically void the warranty. Please contact 
Ross Video Technical Support for more information.

In Case of Problems

Should any problem arise with your pro-xi 100, please contact the Ross Video Technical Support Department. 
(Contact information is supplied at in the section “Contacting Technical Support” on page 12.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific shipping instructions, 
should you wish our factory to repair your pro-xi 100. If required, a temporary replacement will be made available 
at a nominal charge. Any shipping costs incurred will be the responsibility of you, the customer. All products 
shipped to you from Ross Video Limited will be shipped collect. 

The Ross Video Technical Support Department will continue to provide advice on any product manufactured by 
Ross Video Limited, beyond the warranty period without charge, for the life of the equipment.
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Glossary
The following terms are used throughout this guide:

CTC — Single Controller Card

Device — A physical, virtual, or software application that may include multiple sources, destinations, senders, or 
receivers.

EDID — Extended Display Identification Data

GUI button — refers to the left Windows® button (located between the Ctrl and Alt buttons) on your keyboard.

ISC — Incoming System Card

OMD — Over Monitor Display

Start button — refers to the left Windows® button (located between the Ctrl and Alt buttons) on your keyboard.

System— The mix of interconnected production and terminal equipment in your environment.

UMD — Under Monitor Display

VOC — Video Output Card
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